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1 CONNECTING TO DATA 

Data is the base of every analysis, we will use Excel to connect to the Tabular model, where the data 

is stored and prepared for the business user. 

The tabular model resides on the SQL Analysis Services Server, so to get to the data, we first need to 

connect to the server. 

1.1 Creating a new Connection 

Procedure for connecting to Tabular model on Analysis Services is as follows: 

Go to: Data >> Get External Data >> From Other Sources >> From Analysis Services 

 

 

In Connect to Database Server window write your server’s name. Choose Windows or User 

authentication. Press Next. 
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In Database and Table window choose your database and select designated cube. Press Next. 

 

 

In Save Data Connection and Finish window choose the file name for your data connection. We 

recommend you also fill in Description, Friendly Name and Search Keywords fields. Press Finish. 

 

 

As an optional last step, you can also select where and what you want to create based on this 

connection (Pivot Table Report – pivot table, Pivot Chart and Pivot Table Report – pivot chart and 

pivot table, Only Create Connection – Create connection, Existing worksheet, New worksheet) 
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You are now left with a blank pivot table placeholder, pivot table field list and pivot table tools tabs.  

Also, a new connection file has been created on your file system (by default C:\Users\YOUR 

USERNAME\Documents\My Data Sources). 

 

1.2 Using an existing connection 

Whenever you create a new connection or receive a connection file from someone else, it is available 

for you to use, without having to go through the process in the previous step. 

For example, your administrator could define the connection, save it on your network and you can 

use it create your reports. 

Procedure for connecting to tabular model based on an existing connection: 

Go to: Data >> Existing Connections 
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In the next windows you can choose which of the existing connection files you want to use. 

 

1.3 Changing an existing report connection 

Once you create a pivot table that pivot table will be associated with a connection. You can always 

change the connection the pivot table uses. 

Go to: PivotTable Tools >> Change Data Source 
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Then in the next window click Choose Connection and select the connection you want to use. 

 

1.4 Refreshing a connection 

To refresh the data, you need to refresh the connection which effectively connects to the OLAP cube 

and returns the latest data available. 

One connection can only be linked to a single OLAP cube. You can however have several connections 

in a workbook, though each pivot table can only be based on a single connection. 

You can refresh individual connections, or you can refresh all connections at once. 

Go to: Data >> Refresh All (or Refresh) 
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1.5 Connection properties 

Each individual connection has several properties you can set. To view the list of all connections in a 

workbook go to Data >> Connections, which will bring up the Workbook Connections windows. 

 

Besides having the option to also delete and refresh individual connections from this window, you 

can click on the properties button to bring out the properties of the chosen connection. 

On the usage tab you can control:  

1. The refresh rate of the connection: 

 Refresh every X minutes 

 Refresh data when opening the file 

2. OLAP Server Formatting for numbers, fonts, and colors. 

3. OLAP Drill Through which controls the number of records retrieved when performing drill 

though (seeing the numbers behind the number). 

4. Language settings, which, when available, returns the names of dimensions and measures in 

the language of the MS Office. 
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On the definition tab you can control:  

1. The connection file used by the connection (which you can also change). 

2. The connection string and command text (which you can also modify). 

3. The Excel Services authentication settings which are important if you plan to use your Excel 

files with SharePoint Excel Services. 
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1.6 Exercises 

Exercise 1 – Creating a new connection 

Step 1: Select to create a new Analysis Services connection 

Step 2: Connect to the server BI4NAV 

Step 3: Select the BI4NAV database 

Step 4: Select sales cube 

Step 5: Rename you connection 

Step 6: Select to create a pivot table report on the existing worksheet 

Exercise 2 – Use an existing connection 

Step 1: Select to use existing connection 

Step 2: Select the connection you created in the previous exercise 

Step 3: Select to create a pivot table report on the existing worksheet 
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2 PIVOT TABLE OVERVIEW 

In Excel, a pivot table has 3 unique parts: 

- Pivot table filed list, which shows the structure of the OLAP cube at the top and provides 

placeholders for the desired layout of your pivot table. 

- Pivot table preview, where the pivot table will be created. 

- PivotTable tools tabs in main menu, where you can find various options to modify your pivot 

table. 
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2.1 Pivot table field list 

Pivot table field list contains dimension and 

measures. 

By checking checkboxes, we filter the data 

cube. 

Checked attributes are automatically 

positioned in pivot table rows and columns. 

This can be done manually by dragging and 

dropping the attribute into Column Labels, 

Row Labels, and Values in Report Filters. 

For each dimension we can examine its 

hierarchy by clicking on the arrow on the 

side. 

Filters can be added to reports in Report 

Filter. 

 

 

  



12 

2.2 Pivot table preview 

Pivot table preview is divided in data description (dimensions) part and data value part. 

Data description part contains: 

- Header filter (global data filter), 

- Row filter (filter applied on rows) and 

- Column filter (filter applied on columns). 

 

 

2.3 Pivot Table tools tabs 

PivotTable tools tabs are automatically shown when clicking on one or more pivot table cells. 

 

 

 

1. Pivot Table Name – name of pivot table. 

2. Options – changing pivot table options. 

3. Active Field – show active cell name. 

4. Field Settings – changing cell settings (sum, format cell…). 

5. Drill Down – Shows the items children. 

6. Drill Up – Shows the level above this item. 

7. Expand Field – Expanding all items of the active field. 

8. Collapse Field – Collapsing all items of the active field. 

9. Group Selection – Active on column and row header. Grouping data. 

10. Ungroup – Active on column and row header. Ungrouping data. 

11. Group field – Group numeric or date fields. 

12. Insert Slicer – Inserting different slicers. 

13. Insert Timeline – Inserting a timeline to filter dates interactively. 

14. Filter Connections – Manage which filters the Pivot Table is connected to. 

15. Refresh – Refreshing data from the data source. 

16. Change Data Source – Choose a different data source. 

17. Clear – Clear pivot table. 

18. Select – Select parts of pivot table. 

19. Move Pivot Table – Moving pivot table (into new sheet). 

20. Fields, Items, & Sets – Defining additional groups. 

21. OLAP tools – Working without a connection to OLAP cube and converting into formulas. 

22. Relationships – Create or Edit relationships between tables. 

23. Pivot Chart – Adding pivot chart. 

24. Recommended Pivot Tables – Recommended Pivot Tables for your data. 
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25. Field List – Turn on/off data field list. 

26. +/- Buttons – Turn on/off entering dimension hierarchies. 

27. Field Headers – Turn on/off pivot table header. 
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1. Subtotals – turn on/off sum, moving sum in the top or bottom of the table. Sum of selected 

dimension values. 

2. Grand Totals – turn on/off sum total and preview the sum for either column or row values. 

Partial sum of all dimension values. 

3. Report Layout – different report layouts. 

4. Blank Rows – turn on/off blank rows in dimensions. 

5. Row Headers – selecting row header color. 

6. Column Headers – selecting column header color. 

7. Banded Rows – even rows in other color. 

8. Banded Columns – even columns in other color. 

9. Pivot Table Styles – Setting pivot table appearance. 
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3 WORKING WITH PIVOT TABLES 

3.1 Creating, modifying and deleting the pivot table layout 

The first thing we need to do before designing our pivot table is to think about which dimensions 

and measures, we are going to need.  

Once we have identified them, we can select or just drag & drop them to the desired location in our 

pivot table. The fields will be shown automatically in the pivot table preview. 

We can rearrange, add or remove the fields from our pivot table at any time by dragging and 

dropping or by using the arrow buttons and selecting the action from the contextual menu that 

comes up. 

 

 

 

 

 

 

Click on the arrow next to Date YMD and 

select Move to Column Labels. Dimension 

Date YMD will be moved from rows to 

columns. 

Move to Row Labels moves dimension 

from columns to rows. (Row is active only 

if data in the column was previously 

selected) 

We can also use Drag and drop. 
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3.2 Nesting dimensions 

When we set up multiple dimensions in columns/rows, we are talking about dimension nesting. This 

is very useful when we want to see related information from different dimensions grouped together.  

In our example we want to see how well our salespeople did within the years. In the pivot table field 

list, we select the Salesperson - Purchaser dimension and drag it below the Data YMD dimension. The 

order in which dimensions appear is important because the order defines the grouping. 

Adding dimension: 

  

Result: 

 

3.3 Exercises 

Exercise 1 – Creating a new pivot table 

We will create a report showing Net Sales by Customer by country over years 

Step 1: Drag Customer by country to row labels 

Step 2: Drag Date YQMD to columns labels 

Step 3: Select Net Sales and see it being added to the Values 
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Exercise 2 – Modify layout 

Use the report you created in exercise 1 (copy the existing report to a new sheet). 

Step 1: Drag the date dimension in the filter. 

Step 2: Select additional measures: Cost, Profit. 

Step 3: Replace customer by country dimension with Bill to customer dimension in row label 

Step 4:  Which Bill to Customer was the most profitable? HINT: (Sort on Profit from biggest to 

smallest) 
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Exercise 3 – Nesting dimensions 

Use the report you created in exercise 1 (copy the existing report to a new sheet). 

Step 1: Remove the Customer by Country from the report. 

Step 2: Drag Item by Category to rows. 

Step 3: Drag Salesperson-Purchaser below Item by Category in rows. 
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4 DATA DISPLAY OPTIONS 

4.1 Dimension browsing (hierarchies) 

Dimension browsing is one of the most interesting pivot table features. Each dimension usually has 

at least one hierarchy defined. By browsing a specific dimension hierarchy, we can access more 

detailed data in a very simple and effective way just by clicking on + next to the dimension. 

The result is shown in the next picture. The procedure can be repeated until we reach the lowest 

hierarchy level (In our example the lowest level is day). 

 

 

4.2 Sorting data 

Sorting can be performed with standard Excel functionality. In pivot tables we can sort by dimensions 

and measures. Sorting in ascending or descending order is always possible. The more advanced 

options are context based and depend on whether we want to sort dimensions or measures. By right 

clicking a field and selecting Sort >> More Sort options we will be presented with the relevant 

possibilities. 

 

Dimension Sort options: Measures Sort Options: 
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4.3 Filtering data 

Filtering allows us to limit the data presented to us based on certain conditions. Like with sorting, we 

can filter on dimensions and measures and for that we have two types of filters plus a special Top 

filter option:  

 Label filters 

 Value filters 

 Top filter 

Any pivot table can also contain a report filter, which is a dimension filter applied to the entire report. 

Label filters 

Label filters are based on dimension values. 

In our example we wish to display only gross sales in Canada, therefore it is necessary to setup a 

filter on Customer by Country dimension. This is done by clicking on icon   and choosing a filter 

value. We can also filter by multiple values. For more options on setting Label filters, you can also 

select Filter >> Label Filters… 

 

 

 

We can have filters set on rows and columns at the same time for any dimension present. We will set 

up the filter for our date dimension on years 2016 and 2017. 
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If we wish to remove filter, we right click on a dimension value and select Filter >> Clear Filter From 

… in drop down menu. 

Top 10 filters 

We can filter our data to display top X customers, vendors ... To set a Top filter we right click on one 

of the countries in our rows and select Filter >> Top 10… from the drop-down menu.  

In the Top 10 Filter window we control whether we want to select top or bottom members, the 

number of members, whether we want to count them as individual items or percentages and by 

which measure, we want our filter to display. Please note that you can choose any measure in the 

OLAP cube, even if it not present in the pivot table. 

 

 

Value filters 

Value filters are based on the measure values and are set up by right clicking and choosing Filter >> 

Value Filters… from the drop-down menu. 

In the Value Filter window, we select the measure on which we want to base our filter on, and the 

condition for the filter. 

 



24 

Report filters 

Report filter is a separate placeholder in the pivot table layout. Only dimensions can be a part of the 

report filter. By setting report filter you are filtering all the other measures and dimensions in the 

pivot table (in rows, columns and measures). 

Report filters appear above the pivot table and you can set a value by clicking on the  icon next 

to the name. 

 

4.4 Slicers 

A special kind of report filters Excel are Slicers. Slicers offer several advantages over standard report 

filters: 

 They are a much more visual way to present your filters and you can quickly see what you 

have filtered on and even indicate where there is no data. 

 They can be tied to more than one pivot table (if they use the same connection) 

 They can be formatted, customized and rearranged. 

To create a Slicer, you can select the pivot table and click Options >> Insert Slicer. This brings up a 

window where you can select individual hierarchy levels of dimensions to create desired slicers. Each 

level will create a separate slicer. 
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There is a new Slicer Tools tab available when you select a slicer. This gives you several option to 

customize the appearance and behavior of your Slicer. 

 

 

1. Slicer Caption – name of the slicer. 

2. Pivot Table Connections – connection between slicer and pivot table. 
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3. Slicer Styles – slicer style. 

4. Bring Forward – position of the slicer. 

5. Send Backward – position of the slicer. 

6. Selection Pane – turns on the ribbon with all slicers. 

7. Align – position of the slicers. 

8. Group – slicers grouping. 

9. Rotate – rotates the slicer. 

10. Buttons – defining option buttons in the slicer. 

11. Size – defining slicer width and height. 

4.5 Search 

Another powerful feature of Excel is the Search.  

By clicking on the icon   you will see the Search box in the dropdown menu. Based on the selected 

field of the dimension hierarchy you can search for members by typing in the box. The results are 

filtered on-the-fly as you start typing. This is very useful when you want to find a specific member in 

a large dimension (for example a specific customer from the customer dimension, or all documents 

that start with 011…). 

 

 

 

 

 

 

 

 

 

 



27 

4.6 Subtotals, dimension levels display and grouping 

Subtotals 

By default, your pivot table will show Subtotals for various dimension hierarchy levels when you drill 

down. We can turn it off by removing the thick in front of Subtotal option in the right-click drop 

down menu.  
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Dimension levels display 

When browsing dimensions, many times pivot tables become too big. In the 

example above we browsed to the deepest level of Date YQMD dimension.  

We can hide individual level from the hierarchy by right clicking on the field 

and select Show/Hide Fields. This can help us in keeping our pivot tables easier 

to read and understand. In the below example we hid the quarter and day level 

of the Date YQMD dimension. 
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4.7 Exercises 

Exercise 1 – Filters, Search and Sort 

Step 1: Create a new report with Bill-to-Customer in rows, Item by Category in report filters and Net 

Sales and Profit % as measures. 

Step 2: Set the report filter to Disk Product Group by Searching for “DISK” (remember to set the 

Product Group Level!) 

Step 3: Set a TOP 10 display filter by Net Sales 

Step 4: Sort the pivot table descending by Profit%  
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Exercise 2 – Slicers 

Use the report created in the previous exercise. 

Step 2: Click on the pivot table and click Insert Slicer 

Step 3: Select Date YMD Year and under More Fields Month for the Slicers and click OK. 

Step 4: Resize the Month slicer and increase the number of columns to fit all the members. 

Step 5: Filter on Year 2010 and Month of June 
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5 FORMATTING 

5.1 Pivot table formatting 

For pivot table formatting we can use all common Excel formatting functions. We can change font 

size, colors, cell size, cell color...  

Style does not change when we nest dimensions, add new dimensions, refresh data... 

We can find all formatting options in Styles toolbar. We can find it in Microsoft Excel >> Home tab. 

There is also separate PivotTable Styles section on the Design tab of the pivot table Tools group. 

 

 

 

5.2 Displaying and formatting measures 

We manage measures in the same way as dimensions. Usually, we wish to show measures in a specific 

format (numbers, percentage ...) and style (red for negative or based on certain condition). 

 In our example we remove the Sales-purchaser Person dimension and we add the Sales Discount 

Amount measure. By doing this we are able to see by years what the discount amount was. 

Show values as… 

By default, measures are shown in the format defined in the OLAP cubes. But, for example, we are 

sometimes interested in percentage values rather than the actual values. In this way we can monitor 

changing measures throughout a period of time in a more descriptive way. In our example we will 

show Net sales in percentage. 

We select the cells we want to format and right click. In the drop-down menu we select Value Field 

Settings. We can do this also by PivotTable Analyze >> Active Field >> Field Settings. 
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5.3 Conditional formatting 

Conditional formatting enables us to visually indicate outliers based on the conditions we define. 

Including traffic lights into a pivot table is presented in this chapter. Traffic lights help managers to 

observe business indicators and take measures if necessary. There are however other types available 

as well: 

 Highlight Cells Rules – highlight: greater than, lower than, equal to, between… 

 Top/Bottom Rules – Displaying top 10, bottom 10, top 10 %, bottom 10 %, above average, 

below average… 

 Data Bars – graphically displaying cell values. 

 Color Scales – displaying cell color according to its value 

 Icon Sets – displaying cell icons according to its value (arrows, traffic lights…). 

 

First, we must select the cells we want to add traffic lights to. Then we go to Microsoft Excel >> Home 

>> Conditional Formatting >> Icon Sets. 

 

 

 

Selected traffic lights are automatically assigned to rows. By default, Excel selects a light according 

to the averages. If we wish to have our own rules, we click More Rules… 
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In Apply Rule To – we select the location of the traffic light cells. In Select a Rule Type we select a rule 

type. In our case the rule is determined by cell values. In Edit the Rule Description we set up rules for 

each light. We click OK. 
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5.4 Exercises 

Exercise 1 - Formatting 

Create report Sales by country in Dec 2019 over multiple measures. 

Step 1: Connect to server to establish connection to Sales cube. 

Step 2: Select Customer by country (Row label). 

Step 3: Drag Net sales, Net sales YTD and Net sales YTD index in column label 

Step 4: Which country has the biggest YTD index (sort)? 

Step 5: Show net sales as % of Column Total. 

Step 6: Format numbers to remove decimals. 
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Exercise 2 

Bill to sell to ship to over net sales 

Step 1: Copy existing report you created in exercise 1 on same sheet. 

 Step 2: Remove all measures except net sales. 

Step 3: Filter year 2017 in the background. 

Step 4: Filter country United Kingdom in the background. 

Step 5: Add Ship to Name and Sell to Customer - Customer dimension in row label. 

Step 4: Add additional measures Sales Shipped Quantity, Shipped Invoiced Quantity Variance in 

column labels. 

Step 5: Format measures (no decimals) 

 

End result 
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Exercise 3 

Sales/purchaser over multiple measures over customer by country and year 2019 Dec. 

Step 1: Create new report on the same sheet. 

Step 2: Select Salesperson: Salesperson - Purchaser dimension and drag it to row label. 

Step 3: Drag Net sales, profit, Net sales YTD Last … to Values label. 

Step 4: Put Date dimension in the report filter and set filter 2019 – Dec. 

Step 5: Put Customer by country dimension in report filter and set it for Switzerland. 

Step 6: Format numbers. 
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Exercise 4 

Trend analysis: Net sales over quarters and years for GB by posting group. 

Step 1: Create new report on the same sheet. 

Step 2: Drag in Date dimension YMD in row label. 

Step 3: Drag in Quarter (separate date dimension under Calendar) in column label. 

Step 4: Set up Customer by country in background filter and set it for United Kingdom. 

Step 5:  Show net sales as percentage of row total (HINT: Select all measures > right click > value 

field settings). 

Step 6: Format cells to get the similar result as in the picture. 
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6 CHARTS 

6.1 Pivot charts vs. Normal charts 

Pivot charts are linked with the pivot table. Whatever changes you make in the pivot table are 

immediately reflected on the chart and vice versa. Everything in the pivot table is also present on the 

chart. 

Normal charts on the other hand, must be manually defined and therefore any changes to the pivot 

table don’t automatically reflect in the chart. Although this can be seen as a downside, it also gives 

you a lot more options in customizing your chart independently of the pivot table. 

Pivot table and pivot chart commands comparison 

Pivot table Description Pivot chart Description 

Values Sum of numeric data Values Sum of numeric data 

Row labels Displaying fields on a margin 

of the report 

Axis fields 

(Categories) 

Displaying fields on chart axis 

Column 

labels 

Displaying fields in the top of 

the report 

Legend fields 

(Series) labels 

Displaying fields in chart legend 

Report filter It is used for filtering reports 

by selected criteria 

Report filter It is used for filtering reports by 

selected criteria 

 

Pivot charts are dynamical structures because pivot tables have that characteristic. Inserting a pivot 

chart is very easy. We go to Options >> Tools >> Pivot Chart and Insert Chart window is displayed. 
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6.2 Chart design 

When we click on the chart Pivot Chart Tools tab is displayed. 

 

 

Here we have several tools for chart design. 

 

1. Add Chart Element – Add axes, titles, labels, legend etc. 

2. Quick Layouts – Change chart layout, legend, background etc. 

3. Change Colors – Change colors of chart. 

4. Switch Row/Column – Move values from rows to columns. 

5. Select Data – Selecting chart data. 

6. Change Chart Styles – Change chart template. 

7. Move Chart – Moving chart to another sheet. 

6.3 Chart Format 
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1. Chart Area – Displays current chart selection 

2. Format Selection – Formatting selection (color, fill, font style, …). 

3. Reset to Match Style – default style. 

4. Insert Shapes – Insert different shapes. 

5. Shape Styles – Edit chart border. 

6. WordArt Styles – Edit text style/font. 

7. Arrange – Edit chart position. 

8. Size – Edit chart size. 

6.4 Analyze chart options 

 

 

1. Active field - Editing chart analysis area. 

2. Insert Slicer – Adding additional slicers. 

3. Insert Timeline – Add additional date slicers. 

4. Refresh – Refreshing data. 

5. Change Data Source – Change source of the data. 

6. Clear – Clear filters. 

7. Move Chart – Move chart to another sheet or create own sheet. 

8. Fields, Items & Sets – Calculated fields, items and creating and managing sets. 

9. OLAP tools – MDX calculated measure, members etc. 

10. Field List – Turn on of field list. 

11. Field Buttons – Turn on chart buttons. 

 

Data is refreshed by clicking Refresh icon in Analyze tab or by right clicking on a cell and selecting 

Refresh option in drop down menu.  

6.5 Sparklines 

Sparklines are a special in-cell chart type introduced in Excel 2010. They are great for showing trends 

over time. Because they are in-cell charts, they take very little space and are used to provide a general 

overview. 

To insert a sparkline, select the data you want to chart and click on the type of sparkline you want to 

create on the Insert tab in the ribbon. The types available are: 

 Line 

 Column 

 Win/Loss 

You also must specify the location range, that is, the cells where the sparklines will appear. Note that 

you also must select a cell for each series of the sparkline. Multiple series will be grouped together 

by default, meaning they share the same characteristics. You can ungroup or group individual 

sparklines together as you wish later. 
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After you create the sparkline another tab with the options to customize your sparkline will be 

created in the ribbon. 

 

 

 

 

 Edit data – Allows you to change the data range used to plot the sparklines. 

 Type – Change the type of the sparkline. 

 Show – High and low points, first and last points, negative points or markers for individual 

data points. 

 Style - Change the style of the sparklines. 

 Sparkline color – Change the color and thickness of the sparklines. 

 Marker color – Change the color of individual marker points. 

 Axis – Customize axis settings. 

 Group & Ungroup – Allows you to group or ungroup individual sparklines 

 Clear – Clear grouping. 
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6.6 Exercises 

6.6.1 Exercise 1 – Charting 

Step 1: Create a report showing Net Sales and Profit % over Years 

Step 2: Select the entire data range and Insert a column chart 

Step 3: On the Format tab select the “Series Profit%” from the dropdown menu in current selection 

and then click format selection 

Step 4: In the new window that open select to plot the series on the secondary axis. Note the change 

in you chart. 

Step 5: While still having the series selected, right click on it in the chart and select to change the 

chart type to line chart. 
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6.6.2 Exercise 2 - Sparklines 

Step 1: Create a report showing Net Sales of your product categories over individual months 

Step 2: Select the entire data range and insert Line sparkline 

Step 3: Select the cells to the right of the pivot table as the location range for the sparklines and click 

OK 

Step 4: Make sure all the sparklines use the same minimum and maximum for vertical axis 

Step 5: Highlight the Last point with a red bullet 
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7 REPORTING EXERCISES 

7.1 Sales cube 

Exercise 1 

Create new report: Sales YTD analysis 

 

Measures: Net sales, Net sales YTD index 

Dimensions: Date YQMD  

 

NOTE (Format the chart and add data labels to match the picture) 
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Exercise 2 

Create new report: Date trend analysis 

 

Measures: Date (YMD), Date Quarter (separate dimension) 

Dimensions: Net sales (HINT: displayed as percentage) 

 

NOTE (Format the chart and add data labels to match the picture) 
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Exercise 3 

Create new report: Top items by category group analysis 

 

Measures: Net sales 

Dimensions: Item by category product group, Item GL resource asset, Date 

 

NOTE (Format cross table to match the picture) 
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Exercise 4  

Create new report: Top 80 % Items by Net sales over years 

Measures: Net sales 

Dimensions: Item, Type, Date 

 

NOTE (Format cross table to match the picture) 
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Exercise 5 

Create new report: Top 10 customers by net sales over years 

 

Measures: Net sales 

Dimensions: Type, Sell to customer - Customer, date 

 

NOTE (Format cross table to match the picture) 
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Sales Dashboard overview 
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7.2 Inventory cube 

Exercise 1 

Create new report: Inventory trend analysis  

 

Measures: stock value, stock turnover days 

Dimension: Date (YQMD), Company (UK 2009), Location (all), Insert line chart 

 

NOTE (Format the chart and add data labels to match the picture) 
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Exercise 2 

Create new report:  Inventory trend over years by location 

 

Filter: top 5 locations by stock value 

 

Measures: Stock value 

Dimensions: Company, Location, date 

 

Conditional formatting: Data bars  

 

NOTE (Format the chart and cross table to match the picture) 
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Exercise 3 

Inventory trend over Item by Vendor 

 

Filter: Top 5 vendors by stock value 

 

Measures: Stock value 

Dimensions: Item by vendor, Date, Company 

 

Insert bar chart 

 

NOTE (Format the chart and cross table to match the picture) 
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Exercise 4 

Create new report:  Inventory stock value over Item by vendor and over Location for year 2018 

 

Filter: Top 5 Items by stock value 

 

Measures: Stock value 

Dimensions: Company, Date, Item by vendor, Location 

 

NOTE (Format the chart and cross table to match the picture) 
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Exercise 5 

Create new report:  Item by vendor (London post master) by location (LOC 1) for year 2018 over 

stock value and stock rotation (days). 

 

Filter: top 5 items by Stock Turnover Days 

 

Measures: Stock value, Stock Turnover Days 

Dimensions: Date, Location, Item by vendor, Item 

 

NOTE (Format the chart and cross table to match the picture) 
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Inventory Dashboard overview 
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7.3 General ledger/Account schedules cube 

Exercise 1 

Create new report: Balance sheet by multiple measures for Budget v1, year 2019 and company UK 

2009 

 

Measures: GL Net change, GL Debit Amount, GL Credit Amount, GL Net Change YTD, GL Net change 

YTD Last, GL Net Change YTD Index 

Dimensions: GL account by levels, Company, GL Budget, Date YMD 

 

NOTE (Format cross table to match the picture) 
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Exercise 2 

Create new report:  GL account by level over multiple companies in year 2019 

 

Measures: GL Net Change 

Dimensions: GL by account, Company, GL budget, Date YMD 

 

NOTE (Format cross table to match the picture) 
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Exercise 3 

Account Schedules 

 

Create new report:  Account schedules PL over Business group for UK 2009 in year 201 9 

 

Measures: Net change 

Dimensions: Account Schedule PL, Date YMD, Company, Dim Area, Business group 

 

NOTE (Format cross table to match the picture) 
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Exercise 4 

Account schedules over multiple companies in year 2019 

 

Measures: Net change 

Dimensions: Date, Company, Account schedules (COST) 

 

NOTE: Format cross table to match the picture 

 

 
 


